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In Depth: Base

OpenOffice.org includes a number of tools to both interface with database servers and 

perform tasks such as enter and edit data. However, for most day-to-day users who have 

humble needs, creating such a setup is rather complicated. It requires some knowledge of 

how databases work on a technical level. For this reason, a new component was added to 

OpenOffice.org 2.0: Base.

Base is a relational database along the lines of Microsoft Access and is perfect for data-

base applications of all sizes, including more modest efforts. For example, you could use 

it to create an inventory database to produce a report showing all products added for a certain 

geographical region on a certain date, or you could use it to catalog items in your personal 

stamp collection.

Relational databases such as those created by Base are ideal for quickly creating catalogs of 

information, such as inventory lists. In addition to making database creation simple and 

quick, relational databases let you easily query data to produce reports tailored to indi-

vidual needs.

Base works on a number of levels depending on the knowledge of the user, but in its 

most basic form, it offers a design-based approach to the creation of tables and forms. 

Anyone who has previously created a database under Access will feel right at home.

In this chapter, we’ll work through an example of using Base to create a simple data-

base cataloging a collection of music. You can use the same techniques to create any kind 

of relational database.

Getting Started with Base
Unfortunately, Base isn’t installed on your Ubuntu system by default. You can download 

and install it by clicking System ➤ Administration ➤ Synaptic Package Manager. Click the 

Search button on the toolbar and type openoffice.org-base into the text box. In the list of 

results, click the empty check box alongside openoffice.org-base (don’t click the other 

results!) and click Mark for Installation. You’ll see a dialog box informing you that some 

additional programs need to be installed—this is fine. Click the Mark button in the dialog 

box to dismiss it. Then click the Apply button on the main toolbar, and the Apply button 
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in the subsequent dialog box that appears. Once the program has been downloaded and 

installed, close the Synaptic Package Manager.

Once installed, you’ll find Base under the Applications ➤ Office menu. When the 

program first starts, the Database Wizard guides you through either creating a new data-

base or opening an existing one, as shown in Figure 26-1. Once you’ve made your choice, 

click Next to continue.

The first step in creating a new database is to register it within OpenOffice.org. This 

means that it will be made available in other OpenOffice.org programs, such as Calc or Writer. 

Although the knowledge needed to use a database in this way is quite advanced, there’s no 

harm in agreeing to this option. It might prove useful in the future as you learn more about 

OpenOffice.org.

Following this, you can choose to open the database for editing and/or start the Table 

Wizard. Once you click the Finish button, you’ll be invited to give the database a name 

and save it immediately.

Figure 26-1. Base starts with the Database Wizard to facilitate the quick and easy creation of 

new databases.

■Note  Databases aren’t like other office files in that they automatically save and update themselves. 

When using the finished database, you can simply enter data and then quit the program, without needing to 

deliberately opt to save the file.
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Assuming that you did not opt to go directly to the Table Wizard, you’ll now see the 

main Base program window. The right of the Base program window contains the Tasks 

and Data panes. The Tasks pane allows you to create new database elements, depending 

on what’s selected in the Database pane. The Data pane shows any elements you’ve already 

created, and its content changes depending on whether you have the Tables, Queries, 

Forms, or Reports mode selected in the Database pane, on the left. The components of the 

Database pane relate to the four typical elements of a database, and they are as follows: 

Tables: A table is what holds the actual data you’ll eventually input. Therefore, a table 

is the first thing that needs to be created within a new database. Creating a table 

involves defining the types of data that you want to store and giving the individual 

data fields easy-to-understand names.

Forms: Although it’s possible to enter data directly into a table, it isn’t particularly intu-

itive or easy. Because of this, forms are used to make the data fields presentable. As 

the name suggests, in terms of layout these are not unlike the paper forms that you fill 

in to facilitate the collection of data by businesses. As with tables, forms must be created 

from scratch in a new database. Forms have controls, which are used to facilitate data 

entry, or to allow users to navigate the database or otherwise manipulate it. The most 

common type of control is a text-entry field, which is then tied to a data field within 

the table, but you can also have controls that perform certain functions, such as deleting 

a record in the database.

Queries: A query is a way of filtering the database so that you see only a subset of it. 

For example, in a database detailing sales figures from across the country, you might 

create a query to show only the data from a particular state.

Reports: A report is a way of presenting data for human consumption, usually in a 

printed format. For example, you could create a report that details sales figures in the 

form of a letter, or you might make a report to produce address labels using addresses 

stored in the database.

■Note  The usefulness of both queries and reports are that they can be saved and used over and over again, 

so you could use the same query each month to examine just a small section of the data. Base offers wizards 

to automate the creation of both queries and reports.

Double-clicking an item in the Database pane displays or activates that item. Right-

clicking a Database pane item displays a variety of options related to editing the file.

Now, let’s work through an example of using Base. First, you’ll create a table, and then 

you’ll create a form.
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Creating a Database
As an example of using Base, you’ll build a database, ready for data entry. The first step in 

the creation of a database is to make a table. This will hold the data that you will eventually 

enter using a form.

Adding a Table

As with all components within Base, you can use a wizard to create the table. The Table 

Wizard offers a number of predefined data fields corresponding to typical databases. It 

is fine for general use, but if you have a specific and unusual database in mind, you will 

need to create the table manually.

Here, you’ll create a database to catalog CDs. This is easily accomplished with the 

Table Wizard, as follows:

1. Click the Tables icon in the Database pane, and then click the Use Wizard to Create 

Table icon. The Table Wizard starts.

2. You’re given a choice between creating a business or personal database. As you 

would expect, business databases are likely to contain fields relating to business 

matters, such as accounting, and the fields in the personal section relate more to 

domestic matters. Choose Personal for this example.

3. Choose an entry from the Sample Tables drop-down list. For this example, select 

CD Collection.

4. In the Available Fields box, you now see a number of data fields that would prove 

handy for a CD collection. You don’t need to use all of these. Instead, select only 

those you want in your table, and then click the single right-facing arrow button to 

transfer them to the Selected Fields box. For this example, select AlbumTitle, Artist, 

ReleaseYear, and Review, as shown in Figure 26-2. Then click the Next button. 

(Don’t worry if you find the fields lacking or if you want to add your own—you’ll see 

how to do just that in step 6).

5. Check to make sure the fields you selected are of the correct type. Click each to see 

the information in the right area of the dialog box. Fields can take various forms 

depending on what kind of data they’re supposed to hold. For example, one field 

might be designed to contain text, while another might need to contain numbers. Yet 

another might need to contain dates, and some can even contain pictures. As you 

might expect, the wizard has automatically selected the correct data types for the 

predefined fields. 
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Figure 26-2. The Table Wizard contains ready-made data fields for a wide variety of uses.

6. For this example, you want to add a check box that shows whether the CD is scratched. 

If the CD in question is scratched, the user can click in a check box. If the CD isn’t 

scratched, the box can be left blank. To create a check box, you need a special kind 

of data field called a Boolean. This means that the data field can be either true or 

false or, to put it a simpler way, it can hold either yes or no. To create a yes/no data 

field, click the plus button at the bottom of the Selected Fields box. This allows you 

to add another field. In the Field Name box, type Scratched. For the Field Type, click 

the drop-down list and locate the entry marked Yes/No [BOOLEAN]. The other 

options can remain as they are. Click Next to continue.

7. You’re asked if you want to create a primary key. This is the unique numeric field 

that the database uses to keep track of each entry in the database. It’s a must in a 

database like this one. The default choices are correct, so you can click Next again.

8. You’ve completed the Table Wizard. The next step is to create a form, so select 

Create a Form Based on This Table, and then click the Finish button.
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Creating a Form

Forms are present in databases for the benefit of users to facilitate the quick-and-easy 

entry of data. They present data fields that you’ve just created within the table in an easy-

to-understand form.

Base is able to walk you through the creation of forms via the Form Wizard. If you 

didn’t select to run the Form Wizard previously, you can start it by clicking Forms in the 

Database pane, and then clicking Use Wizard to Create Form. Then follow these steps:

1. In the Form Wizard’s first step, select which fields you want to appear on the form. 

As with the Table Wizard, this is simply a matter of selecting the fields and then 

clicking the right-arrow button so that they appear under the Fields on the Form 

heading. Alternatively, by clicking the double-arrow button, you can select all of 

them in one fell swoop, which is what you want for this example. Click Next.

2. You’re asked if you want to create a subform. As its name suggests, this is effectively 

a form within your main form. A subform is useful with more complicated data-

bases, where it might be necessary to view other data while filling in the form. For 

this simple example, leave the Add Subform box unchecked and click Next.

3. Choose a general layout for the data fields. The default is the table view, which many 

find ugly, so you might choose one of the first two options (in our database we 

chose the second option, as can be see in Figure 26-3). These arrange the data 

fields in a spacious manner and make the form much more usable. If you look 

behind the wizard dialog box, you’ll see a preview of how the form will look. Once 

finished, click Next.

4. You’re asked whether or not you want existing data to be displayed on the form. 

You can choose to treat the form as one created only for entering new data, so that 

you can’t use it to navigate through the database and see existing data you’ve already 

entered. This might be useful in applications where you don’t want users to see the 

other data in the database. However, for a database for your own personal use, being 

able to see the existing data is very handy, which is why The Form Is to Display All 

Data option is selected by default. For this example, simply click the Next button to 

accept the default.

5. Choose a look and feel for your form from the variety of color schemes available, as 

shown in Figure 26-3. Again, you can see them previewed behind the wizard dialog 

box. Feel free to experiment with the options under the Field Border heading. We 

prefer the 3D Look option, which gives the form elements a slight interior shadow, 

a common feature on most modern user interfaces. The Flat option simply adds a 

black border to the boxes, and the No Border option removes the border completely. 

Once you’ve made your choices, click Next.
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Figure 26-3. You can choose from a variety of look and feel options for your form, and each 

will be previewed behind the wizard dialog box.

6. You’re invited to give the form a name. Enter a suitable name, such as CD-Collection. 

You are also given the option of entering data directly into the form or modifying it 

manually. Once you’ve made your choice, click the Finish button. The database is 

almost ready for use. You just need to take one more step to modify the table. However, 

first we’ll take a brief look at adding custom controls to forms.

■Note  There are no rules governing form names, and you can use virtually any symbols and also insert 

spaces into the name. However, it’s a good idea to keep the form name simple and concise.

Adding Controls to the Form Manually

Although the form created by the wizard is good enough for our needs, there might be 

some instances where you want to edit the form manually to add your own controls. The 

following instructions describe how:
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1. Double-click the form to edit it and then ensure the Form Controls toolbar is visible—

click View ➤ Toolbars ➤ Form Controls. Then, on the Form Control toolbar, click the 

icon that represents the control you want to add to the form. Don’t forget, you can 

hover your mouse over each icon to see a tooltip explaining what the icon is for. 

Next click and drag on the form to add the item. You need to make the item big 

enough so that the label can be seen. This is especially relevant in the case of smaller 

items, such as check boxes. If you release the mouse button too early, simply click 

and drag the handles at the edges to resize the control.

2. Once the item has been drawn, double-click it. This will open Properties dialog 

box. Click in the Label box, delete what’s there already, and type the word(s) that 

will help the database users identify the item. 

3. Click the Data tab and, in the Data Field box, select from the drop-down list the 

table data field that you wish to asssociate with the item.

4. Close and save the form.

You can add many custom controls following the same basic approach you used here. 

Simply draw them on to the form, and then match them up with an entry in the table 

using the Data tab.

Editing the Database Table

Before you can use the CD database we created earlier, you need to make a small change 

to the table you created. Although the Table Wizard created a primary key, it didn’t make 

it into an automatically updating number. Without this option activated, the user will 

need to manually number each entry in the database as it’s created. 

Follow these steps to edit the table and activate automatic numbering for the ID field:

1. Click the Tables icon in the Database pane of the main program window, right-click 

the table you created earlier, and select Edit.

2. Look for the entry in the table list labeled ID. It should be first in the list. Make sure 

that the cursor is on the ID line, and click the Autovalue drop-down list at the bottom 

of the window. Make sure that it reads Yes, as shown in Figure 26-4. 

3. Close the window and opt to save the table.

That’s it! Your database is now ready to use.



CH AP T E R  2 6  ■  I N  D E P TH :  B ASE 519

Figure 26-4. Set the primary key to automatically update by editing its value in the table.

Using the Database
Entering data into the finished database is easy. Click the Forms icon in the Database 

pane, and then double-click the form you created earlier.

The Form Control toolbar will still be visible. To hide it, click its close button at the top-

right corner of the toolbar. After this, you can start to enter data into the form, as shown in 

the example in Figure 26-5. Note that you do not need to enter data in the ID field, because 

this will automatically be filled with the primary key number.

Once you’ve filled in the form, you can click the Next Record button in the Form 

Navigation toolbar running along the button of the window (don’t forget that hovering 

the mouse cursor over each button reveals a tooltip explaining what the button does). 

This will move you on to the next blank form, where you can enter more data. Repeat this as 

many times as necessary.

The Form Navigation toolbar contains other handy tools. For example, the first button—

a magnifying glass—lets you search the database for a particular entry. It’s well worth 

investigating the functions.
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Figure 26-5. The finished database form lets you enter data into the input fields and navigate 

using the toolbar at the bottom.

Summary
In this chapter, we looked at the Base database component of OpenOffice.org and how to 

use it to easily create and edit simple databases. We stepped through an example of setting up 

a database table and creating a database form that users can employ to enter and edit data.

In the next chapter, we will look at Evolution, the powerful e-mail and personal infor-

mation manager offered under Ubuntu.


